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Note pour les utilisateurs Mac

Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et 
Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce 
chapitre. Pour une liste plus détaillée, voyez dans l'Aide.

Windows/Linux Équivalent Mac Effet

Sélection de menu 
Outils > Options

LibreOffice > Préférences Accès aux options de paramétrage

Clic droit ⌘+clic Ouvre un menu contextuel

Ctrl (Contrôle) ⌘ (Commande) Utilisé avec d'autres touches

F5 Maj+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles & Formatage
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Introduction

Ce chapitre couvre les méthodes pour éditer des documents partagés : partager (collaboration), 
enregistrer les modifications, ajouter des commentaires, réviser les modifications, fusionner et 
comparer des documents, enregistrer et utiliser des versions des documents. Les techniques 
d’édition de base sont abordées dans le Chapitre 2 (Entrer, modifier et formater des données).

Partager des documents (collaboration)

Dans LibreOffice Writer, Impress et Draw, un seul utilisateur à la fois peut ouvrir un document pour 
édition. Dans Calc, plusieurs utilisateurs peuvent ouvrir simultanément le même classeur dans le 
mode écriture.

Il est fortement recommandé que chaque collaborateur saisisse son nom dans Outils > Options >
LibreOffice > Données d’identité. Dans le cas contraire, ses contributions (modifications et 
commentaires) seront créditées à un auteur inconnu.

Certaines commandes des menus sont indisponibles (grisées) quand l’enregistrement des 
modifications ou le partage du document est actif.

Paramétrer un classeur pour le partage
À tout moment, vous pouvez paramétrer un classeur pour le partager avec d’autres utilisateurs. 
Une fois le classeur ouvert, choisissez Outils > Partager le document pour activer les 
fonctionnalités de collaboration pour ce document.

Figure 1 : Choisir de partager un classeur

Pour activer le partage, cochez la case en haut de la boîte de dialogue, puis cliquez sur OK. Un 
message apparaît vous indiquant que vous devez enregistrer le document afin d’activer le mode 
partagé. Cliquez sur Oui pour continuer. La mention (partagé) est alors affichée dans la barre de 
titre, à la suite du nom du fichier.
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La commande Outils > Partager le document peut être utilisée pour basculer un document du 
mode non partagé au mode partagé. Cependant, si vous voulez utiliser un document partagé en 
mode non partagé, vous devez d’abord enregistrer le document partagé avec un autre nom ou un 
autre chemin. Ceci crée une copie du classeur qui n’est pas partagée.

Ouvrir un classeur partagé
Lorsque vous ouvrez un classeur qui est en mode partagé, un message apparaît vous indiquant 
que le document est en mode partagé et que certaines fonctionnalités ne sont pas disponibles 
dans ce mode. Cliquez sur OK, et le document est ouvert en mode partagé.

Les fonctions suivantes ne sont pas disponibles dans un classeur partagé :

Édition > Modifications, sauf Fusionner le document
Édition > Comparer le document
Édition > Feuille > Déplacer/copier et Supprimer
Insertion > Cellules > Déplacer les cellules vers le bas et Déplacer les cellules vers la droite
Insertion > Feuille à partir d’un fichier
Insertion > Noms
Insertion > Commentaire
Insertion > Image
Insertion > Vidéo et son
Insertion > Objet, sauf Diagramme à partir d'un fichier
Insertion > Cadre flottant
Format > Feuille > Renommer et Couleur d’onglet
Format > Fusionner les cellules
Format > Zones d’impression
Outils > Protéger le document
Données > Définir la plage
Données > Trier
Données > Sous-totaux
Données > Validité
Données > Opérations multiples
Données > Consolider
Données > Plan et groupe
Données > Table de pilote

Enregistrer un classeur partagé
Quand vous enregistrez un classeur partagé, une des situations suivantes peut se produire :

• Si le document n’a pas été modifié et enregistré par un autre utilisateur depuis que vous 
l’avez ouvert, le document sera enregistré.

• Si le document a été modifié et enregistré par un autre utilisateur depuis que vous l’avez 
ouvert, l’un des événements suivants va se produire :

– Si les changements ne sont pas en conflit, le document est enregistré. Un message 
apparaît, vous indiquant que votre classeur a été mis à jour et enregistré par d’autres 
utilisateurs, et toutes les cellules modifiées par l’autre utilisateur apparaissent avec 
une bordure rouge.

– Si les changements sont en conflit, la boîte de dialogue Résoudre les conflits s’ouvre. 
Vous devez décider pour chaque conflit quelle version conserver, la vôtre ou celle de 
l’autre personne. Lorsque tous les conflits sont résolus, le document est enregistré. 
Pendant que vous résolvez les conflits, aucun autre utilisateur ne peut enregistrer le 
document partagé.

• Si un autre utilisateur essaie d’enregistrer le document partagé et de résoudre les conflits, 
un message apparaît vous indiquant que le fichier classeur partagé est verrouillé à cause 
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d’une fusion en cours. Vous pouvez alors renoncer à la commande Enregistrer pour le 
moment, et réessayer plus tard.

Une fois que vous avez enregistré avec succès un document partagé, le document affiche la toute 
dernière version de tous les changements enregistrés par tous les utilisateurs.

Enregistrer les modifications

Vous pouvez utiliser plusieurs méthodes pour enregistrer les modifications que vous ou d’autres 
utilisateurs faites dans un document.

• Vous pouvez utiliser les marques de modifications pour montrer les ajouts, les 
suppressions et les changements de formats. Plus tard, vous (ou un autre utilisateur) 
pourrez réviser le document et accepter ou rejeter chaque modification.

• Si vous n’utilisez pas le partage de fichier, vous pouvez effectuer les modifications dans 
une copie du document (enregistré dans un dossier différent, avec un nom différent, ou les 
deux), puis utiliser Calc pour comparer les fichiers et mettre en évidence les changements. 
Voir "Comparer des documents" page 15.

• Vous pouvez enregistrer des versions qui seront conservées dans le fichier original. Voir 
"Enregistrer des versions" page 16.

Les relecteurs peuvent laisser des commentaires dans le document, attachés à des modifications 
particulières ou autonomes.

Note Ces outils sont identiques à ceux utilisés dans Writer pour le suivi des modifications.

Préparer un document pour la révision
Quand vous envoyez un document à un autre utilisateur pour révision ou édition, vous pouvez tout 
d’abord vouloir le protéger afin que l’éditeur ou le relecteur n’ait pas à se souvenir de bien activer 
les marques de modifications. Une fois que vous avez protégé le document, tout utilisateur doit 
entrer un mot de passe correct pour désactiver la protection et accepter/rejeter les modifications.

1) Ouvrez le document et sélectionnez Édition > Modifications > Enregistrer. Une coche 
apparaît devant cette option pour indiquer que l’enregistrement est actif.

2) (Optionnel) Cliquez sur Édition > Modifications > Protéger l’historique. Dans la boîte de
dialogue Protéger l’historique, saisissez un mot de passe, confirmez-le et cliquez sur OK.

Identifier les copies des classeurs
Si vous n’utilisez pas la fonctionnalité de partage du document, il peut être important de garder une
trace des différentes copies de ce document. Ceci peut être effectué dans le nom ou dans le titre 
du fichier. Si vous n’avez pas donné de titre au fichier dans les propriétés du classeur, le nom de 
fichier du classeur est affiché dans la barre de titre. Pour déterminer le titre du classeur, 
sélectionnez Fichier > Propriétés onglet Description.

Enregistrer les modifications
La suite de ce chapitre va être illustrée par l’exemple de l’élaboration d’un budget pour une équipe 
de football.

Mettez-vous dans la situation d’un président d’un club de football. L’entraîneur d’une équipe de 
jeunes vous a soumis un budget pour la saison, et vous avez besoin de le modifier et de lui 
retourner la nouvelle version.

Vous vous inquiétez du fait que, si vous faites simplement des modifications, l’entraîneur ne verra 
donc pas les changements que vous avez effectués. Vous décidez alors d’utiliser et d’activer la 

Enregistrer les modifications 7



fonctionnalité d’enregistrement des modifications, pour que l’entraîneur puisse voir facilement les 
changements que vous avez effectués.

La Figure 2 montre le classeur du budget que l’entraîneur vous a soumis.

Figure 2 : Classeur budget de l’équipe de football

En examinant les chiffres, vous voyez que vous pourriez économiser sur certains postes :

• Les collations d’après-match peuvent être apportées par les parents.

• Les nouveaux maillots peuvent attendre : en acheter seulement 5 pour remplacer ceux qui 
sont usés.

• Acheter des ballons d’entraînement moins chers.

• Acheter seulement 2 protège-tibias de rechange.

Pour effectuer ces modifications, utilisez l’enregistrement des modifications de Calc. Pour 
commencer cet enregistrement :

1) Ouvrez le classeur contenant le budget.

2) Sélectionnez Édition > Modifications > Enregistrer dans la barre de menus.

3) Commencez à modifier le document.

Une bordure colorée, avec un point dans son coin supérieur gauche (comportement par défaut), 
apparaît autour de la cellule où une modification a été effectuée (Figure 3). Les autres utilisateurs 
peuvent alors facilement savoir quelles cellules ont été modifiées. Une ligne ou une colonne 
supprimée est marquée par une barre colorée épaisse.

Figure 3 : Document édité avec cellules modifiées entourées en rouge

Note
Certaines modifications, comme le formatage d’une cellule par exemple, ne sont pas 
enregistrées et signalées.
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Astuce

Pour modifier la couleur qui signale les modifications, sélectionnez Outils > 
Options > LibreOffice Calc > Modifications. Par défaut, une couleur différente 
sera attribuée à chaque relecteur (s’il a pris soin de renseigner son nom comme 
indiqué dans "Partager des documents (collaboration)" page 5).

Une fois que vous avez terminé vos modifications dans le document, vous pouvez l’envoyer à 
votre entraîneur.

Vous pouvez vouloir expliquer votre raisonnement qui a guidé les modifications effectuées. Vous 
pouvez exprimer votre point de vue de deux manières : en ajoutant des commentaires aux 
changements que vous avez effectués, ou en ajoutant des commentaires globaux au classeur.

Ajouter des commentaires aux modifications

Calc ajoute automatiquement à toute modification enregistrée un commentaire qui précise ce qui a
été modifié (par exemple, Cellule B3 modifiée de '15' en '5'). Les relecteurs et les auteurs peuvent 
ajouter leurs propres commentaires pour expliquer les raisons de leurs modifications.

Pour ajouter un commentaire à une modification :

1) Faites la modification dans le classeur.

2) Sélectionnez la cellule où la modification a été effectuée.

3) Choisissez Édition > Modifications > Commentaires. La boîte de dialogue de la Figure 4
s’ouvre. Le commentaire ajouté automatiquement par Calc ne peut pas être modifié.

4) Saisissez votre propre commentaire et cliquez sur OK.

Figure 4 : Boîte de dialogue du commentaire

Une fois que vous avez ajouté un commentaire à une cellule modifiée, vous pouvez l’afficher (sous
forme d’infobulle) en plaçant le pointeur de la souris au-dessus de la cellule, comme Figure 5 :

Figure 5 : Commentaire ajouté à la cellule B3
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Le commentaire s’affiche également dans la boîte de dialogue où vous acceptez ou refusez les 
modifications, comme illustré sur la première ligne de la Figure 10 page 13.

Modifier les commentaires des modifications
1) Sélectionnez la cellule dont vous voulez modifier le commentaire.

2) Choisissez Édition > Modifications > Commentaires.

3) Modifiez le commentaire et cliquez sur OK.

Ajouter d’autres commentaires

Calc dispose également d’un autre type de commentaires (appelés "notes" dans les anciennes 
versions de LibreOffice), que les auteurs et les relecteurs utilisent souvent pour échanger des 
idées, formuler des suggestions et réfléchir collectivement dans un document.

Pour ajouter un commentaire :

1) Sélectionnez la cellule à laquelle le commentaire va s’appliquer.

2) Sélectionnez Insertion > Commentaire ou faites un clic droit et choisissez Insérer un 
commentaire. Une zone de saisie apparaît, comme Figure 6.

Figure 6 : Insérer un commentaire

3) Saisissez le texte de votre commentaire dans cette zone.

4) Cliquez en dehors de la zone pour la fermer.

La cellule à laquelle vous avez ajouté un commentaire comporte désormais un point coloré dans le
coin supérieur droit, comme illustré Figure 7. Elle n’a pas de bordure colorée, à moins que la 
cellule ait été également modifiée.

Figure 7 : Point coloré dans une cellule 
comportant un commentaire

Note
Si le point coloré n’apparaît pas pour signaler une cellule dans laquelle se trouve un 
commentaire, vérifiez, dans Outils > Options > LibreOffice Calc > Affichage, si 
l’option Indicateur de commentaire est bien cochée.

Astuce

Vous pouvez modifier la couleur d’arrière-plan par défaut des commentaires dans 
Outils > Options > LibreOffice > Apparence section Classeur. Vous pouvez 
aussi modifier individuellement la couleur d’arrière-plan de chaque commentaire : 
voir "Formater les commentaires" page 11.
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Pour afficher le commentaire que vous venez d’ajouter, placez le pointeur de la souris au-dessus 
de la cellule correspondante ; le commentaire apparaît, comme ci-dessous.

Figure 8 : Afficher un commentaire

Modifier des commentaires
Vous pouvez modifier et formater le texte d’un commentaire, comme vous le feriez pour tout autre 
texte.

1) Faites un clic droit dans la cellule contenant l’indicateur de commentaire et choisissez 
Afficher le commentaire dans le menu contextuel.

2) Sélectionnez le commentaire, puis double-cliquez à l’intérieur. Le curseur change d’aspect 
pour prendre sa forme habituelle qui marque l’entrée de texte en clignotant, et la barre 
d’outils Formatage qui était indisponible devient active et affiche les attributs du texte.

3) Une fois la modification effectuée, cliquez à l’extérieur du commentaire pour le 
désélectionner. Pour masquer à nouveau le commentaire, faites un clic droit dans la cellule
et décochez Afficher le commentaire dans le menu contextuel.

Astuce

Pour modifier un commentaire masqué, faites un clic droit sur la cellule puis 
choisissez Insérer un commentaire. Vous accédez alors directement en 
modification et il suffit ensuite de cliquer en dehors du commentaire pour qu’il soit 
masqué de nouveau.

Formater les commentaires
Vous pouvez changer la couleur d’arrière-plan, le style de bordure, la transparence et d’autres 
attributs d’un commentaire.

1) Faites un clic droit dans la cellule contenant l’indicateur de commentaire et choisissez 
Afficher le commentaire dans le menu contextuel.

2) Cliquez dans le commentaire lui-même. La barre d’outils Formatage change pour afficher 
la plupart des options de formatage des commentaires. Ce sont les mêmes que les options
pour formater les éléments graphiques ; voir le Chapitre 5 (Utiliser des éléments 
graphiques dans Calc) pour plus d’informations.

Vous pouvez également faire un clic droit sur le commentaire pour afficher un menu 
d’options, certaines menant à des boîtes de dialogue vous permettant de paramétrer 
finement le formatage ; ces boîtes de dialogue sont également décrites dans le Chapitre 5.

3) Une fois la modification effectuée, cliquez à l’extérieur du commentaire pour le 
désélectionner. Pour masquer à nouveau le commentaire, faites un clic droit dans la cellule
et décochez Afficher le commentaire dans le menu contextuel.

Rechercher les commentaires en utilisant le Navigateur
Les petits indicateurs de commentaire dans le coin des cellules peuvent être difficiles à distinguer. 
Par conséquent, Calc propose une autre façon de les repérer, en utilisant le Navigateur. S’il existe 
des commentaires dans un classeur, le Navigateur affiche une marque (habituellement le signe + 
ou une flèche) devant le mot Commentaires. Cliquez sur cette marque pour afficher la liste des 
commentaires. Double-cliquez sur le commentaire voulu pour aller directement dans la cellule 
associée.
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Copier des commentaires
Vous pouvez copier un commentaire d'une cellule à l'autre sans modifier le contenu de la cellule 
de destination. Pour ceci :

1) Sélectionnez la cellule d'origine et copiez-la dans le presse-papiers, en choisissant Édition
> Copier ou en appuyant sur les touches Ctrl+C.

2) Sélectionnez la cellule de destination et choisissez Édition > Collage spécial ou appuyez 
sur les touches Ctrl+Maj+V.

3) Dans la boîte de dialogue Collage spécial qui s'ouvre, section Sélection, décochez toutes 
les options et ne laissez que l'option Commentaires cochée. Dans la section Opérations, 
choisissez Addition. Cliquez sur OK.

4) Le commentaire est copié sans que le contenu de la cellule de destination soit modifié.

Réviser les modifications

À ce point de l’explication, vous allez inverser les rôles et devenir l’entraîneur de l’équipe, pour que
vous puissiez voir comment réviser et accepter ou refuser les modifications apportées au 
document.

Vous êtes désormais l’entraîneur d’une équipe de football de jeunes et vous avez soumis une 
proposition de budget annuel au président de votre club. Ce dernier a révisé le document en 
utilisant les fonctionnalités d’enregistrement des modifications dans Calc. Vous voulez maintenant 
réviser ces modifications et accepter ou refuser ces contre-propositions. Étant donné que votre 
président a enregistré ses modifications dans Calc, vous allez pouvoir facilement voir quels 
changements ont été effectués et décider comment agir.

Afficher les modifications
Calc vous donne un contrôle complet sur les modifications que vous affichez lorsque vous révisez 
un document. Pour modifier les filtres en cours, sélectionnez Édition > Modifications > Afficher. 
La boîte de dialogue de la Figure 9 s’ouvre.

Figure 9 : Boîte de dialogue Afficher les modifications
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Au moyen des différents paramétrages, vous pouvez contrôler quelles modifications vont s’afficher
à l’écran. Vous pouvez les filtrer selon :

• les modifications acceptées : seules les modifications acceptées seront affichées ;

• les modifications rejetées : seules les modifications rejetées seront affichées.

Accepter ou rejeter les modifications
Lorsqu’un document vous est retourné avec des modifications, tout l’intérêt de l’enregistrement 
des modifications devient évident. Vous pouvez alors, en tant qu’auteur initial du document, 
parcourir les modifications effectuées et décider de leur sort. Pour commencer ce processus :

1) Ouvrez le document modifié.

2) Sélectionnez Édition > Modifications > Accepter ou rejeter. La boîte de dialogue de la
Figure 10 s’ouvre.

3) Calc parcourt individuellement chaque modification. Vous pouvez accepter ou rejeter 
chaque modification au fur et à mesure.

La colonne Commentaire contient l’explication par défaut de la modification effectuée. Si le 
relecteur a ajouté un commentaire à sa modification, il est affiché avant l’explication par défaut, 
comme sur la première ligne de la Figure 10.

Figure 10 : Boîte de dialogue Accepter ou rejeter les modifications

Si plus d’un utilisateur a révisé le document, un relecteur a pu rectifier une modification d’un autre 
relecteur. Dans ce cas, les modifications sont structurées logiquement avec un signe + qui permet 
d’ouvrir l’arborescence. Les modifications déjà acceptées ou refusées sont également regroupées.

L’onglet Filtrer (Figure 11) vous permet de filtrer les modifications. Après avoir spécifié les critères 
de filtre, revenez à l’onglet Liste pour voir le résultat. Vous pouvez filtrer selon :

• la date : seules les modifications effectuées au cours d’une certaine période seront 
affichées ;

• l’auteur : seules les modifications effectuées par un auteur particulier seront affichées. Ceci
est particulièrement utile si vous avez plusieurs relecteurs pour votre document ;
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• la plage : seules les modifications effectuées dans une plage de cellules particulière seront 
affichées. Ceci est particulièrement utile si votre classeur est volumineux et si vous voulez 
ne réviser qu’une partie du document ;

• le commentaire : seules les modifications dont le contenu du commentaire correspond au 
critère de recherche spécifié seront affichées.

Figure 11 : Filtrer les modifications affichées dans l'onglet Liste

Fusionner les documents

Envisageons le cas de figure où vous avez envoyé votre proposition de budget non seulement au 
président de votre club, mais aussi à votre entraîneur adjoint. Tous les deux vous renvoient leur 
budget révisé en même temps. Vous pourriez réviser chaque document séparément, mais, pour 
gagner du temps et être plus efficace, vous pouvez vouloir analyser l’ensemble de leurs 
modifications simultanément. Pour ceci, vous pouvez utiliser la fonction de fusion de document de 
Calc.

Les méthodes décrites jusqu’ici sont efficaces si vous n’avez qu’un relecteur à la fois. Parfois 
cependant, plusieurs relecteurs renvoient toutes les versions modifiées d’un document en même 
temps. Dans ce cas, il est plus rapide et efficace de réviser toutes ces modifications en une seule 
fois, plutôt que de le faire individuellement pour chaque version. Pour ceci, vous pouvez fusionner 
les documents dans Calc.

Pour fusionner des documents, la fonction d’enregistrement des modifications doit être active pour 
chacun d’entre eux.

1) Ouvrez le document d’origine.

2) Sélectionnez Édition > Modifications > Fusionner le document.

3) Une boîte de dialogue de sélection de fichiers s’ouvre. Sélectionnez le fichier que vous 
voulez fusionner et cliquez sur OK.

4) Une fois la fusion des documents effectuée, la boîte de dialogue Accepter ou rejeter les 
modifications s’ouvre, comme dans la Figure 12, et affiche les modifications de plusieurs 
relecteurs. Si vous voulez fusionner plus de documents, fermez la boîte de dialogue et 
répétez les étapes 2 et 3.
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Figure 12 : Accepter ou rejeter les modifications de documents fusionnés

Les modifications sont alors combinées dans un seul document et vous pouvez les accepter ou les
rejeter au cours d’un même processus. Les modifications de chaque relecteur apparaissent avec 
des couleurs différentes dans le document, comme illustré Figure 13. Dans cet exemple, les 
modifications de Chris sont en rouge et celles de Jean en bleu.

Figure 13 : Documents fusionnés et relecteurs avec des couleurs différentes

Comparer des documents

Parfois, quand vous partagez des documents, les relecteurs peuvent oublier d’enregistrer leurs 
modifications. Ce problème peut être résolu par Calc, qui peut retrouver ces modifications en 
comparant des documents.

Pour comparer des documents, vous devez disposer du document original et de celui qui a été 
modifié. Pour les comparer :

1) Ouvrez le document modifié que vous voulez comparer au document original.

2) Sélectionner Édition > Comparer le document.

3) Une boîte de dialogue de sélection de fichier s’ouvre. Sélectionnez le document original et 
cliquez sur Insérer.
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Attention
Veillez à bien ouvrir le document modifié en premier et non le document original.

Calc détecte et repère les modifications de la façon suivante :

• Toutes les données qui se trouvent dans le document modifié mais pas dans le document 
original sont repérées comme insérées.

• Toutes les données qui se trouvent dans le document original mais pas dans le document 
modifié sont repérées comme supprimées.

• Toutes les données modifiées sont repérées comme modifiées.

À partir de ce point, vous pouvez parcourir ces repères et accepter ou rejeter les modifications.

Enregistrer des versions

La plupart des documents passent par plusieurs versions. Il est souvent utile d’enregistrer les 
nouvelles versions d’un document. Vous pouvez le faire en enregistrant une copie du document 
(sous un nom différent) après chaque révision, ou en utilisant la fonctionnalité de gestion des 
versions de Calc.

Attention Si vous utilisez la commande Enregistrer sous à partir d’un document qui comporte 
plusieurs versions, ces anciennes versions ne seront pas enregistrées dans le 
nouveau fichier.

Pour utiliser la gestion des versions de Calc :

1) Choisissez Fichier > Versions. La boîte de dialogue Versions s’ouvre.

Figure 14 : Boîte de dialogue de gestion des versions

2) Cliquez sur le bouton Enregistrer une nouvelle version pour enregistrer une nouvelle 
version.
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3) Une boîte de dialogue s’ouvre, où vous pouvez saisir un commentaire sur cette version.

Figure 15 : Boîte de dialogue de commentaire de version

4) Après avoir saisi votre commentaire et cliqué sur OK, la nouvelle version est ajoutée dans 
la liste.

Figure 16 : Liste des versions mise à jour

Note
Le nouveau fichier a une taille supérieure, comme si deux classeurs étaient 
enregistrés ensemble.

Une fois le fichier enregistré, les deux versions y sont présentes. Vous pouvez alors :

• ouvrir une ancienne version : sélectionnez la version et cliquez sur le bouton Ouvrir ; une 
copie en lecture seule de l’ancienne version s’ouvre ;

• comparer toutes les versions : cliquez sur le bouton Comparer et une action similaire à la 
fusion de documents s’effectue. Une boîte de dialogue Accepter ou rejeter les modifications
s’ouvre et liste toutes les modifications à travers les différentes versions ;

• modifier le commentaire : sélectionnez une version et cliquez sur le bouton Afficher pour 
afficher le commentaire saisi par vous ou d’autres relecteurs.
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